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Thank you for purchasing FlashBus Spectrim, a high-per-
formance, PCI bus-mastering video frame grabber designed
to capture composite, S-Video, or RGB video in real time to
system or display memory.

This chapter introduces you to the FlashBus Spectrim card’s
features.

1Introduction
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About FlashBus Spectrim

FlashBus Spectrim is a high-performance, PCI bus-mastering video frame grab-
ber designed to capture composite, S-Video, or RGB video in real time to system
or display memory. Utilizing a Philips TriMediaTM Video Processor and 16MB of
SDRAM memory, FlashBus Spectrim is a perfect general-purpose capture card
for OEM requirements. FlashBus Spectrim also provides video output, I/O trig-
gering, and camera integration support.

Product Features
• Bus-mastering video acquisition
• Philips TriMediaTM Video Processor
• Real-time transfer of video to system or display memory
• 16MB SDRAM frame buffer
• High-quality video scaling to arbitrarily sized windows
• Up to 4 RGB or YCbCr, 8 S-Video, and 16 composite multiplexed video
inputs
• RGB, YCbCr, S-Video, and composite video output
• CCIR and square pixel capture resolution
• NTSC and PAL video formats
• Area of interest transfers to/from system and on-board memory
• Fast video input switching capability
• On-board microcontroller
• General-purpose I/O triggers
• Optically isolated trigger output for flash control
• Programmable DAC output
• RS-232 output support
• Camera integration support
• 12 volt DC switched output for camera supply
• Real-time image flip, rotate, and mirror
• Windows 98, ME, NT 4.0, 2000, and XP drivers
• Windows-based FBG video capture application
• Optional SDK with sample applications
• Compatible with IVL Vision Library
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About FlashBus Spectrim Lite

FlashBus Spectrim Lite is a low-cost PCI bus-mastering video capture card that
is perfect for cost-sensitive applications. Spectrim Lite also utilizes the Philips
TriMedia video processor and same enhanced video digitization as the full-fea-
tured Spectrim. Sprectim Lite supports up to three composite inputs or a single S-
Video input, and has a single trigger I/O for TTL or strobe interfaces.

Product Features
• Bus-mastering video acquisition
• Philips TriMediaTM Video Processor
• Real-time transfer of video to system or display memory
• 16 MB SDRAM Frame Buffer
• High-quality video scaling to arbitrarily sized windows
• Up to 3 multiplexed composite or one S-Video inputs
• CCIR and square pixel capture resolution
• NTSC and PAL video formats
• Area of interest transfers to/from system and on-board memory
• Fast video input switching capability
• General purpose I/O trigger
• Real-time image flip, rotate, and mirror
• Windows 98, ME, NT 4.0, 2000, and XP drivers
• Windows-based FBG video capture application
• Optional SDK with sample applications
• Compatible with IVL Vision Library
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Installation consists of inserting the FlashBus Spectrim
board in the computer, installing the display driver, and
running a setup program from two disks. This chapter con-
tains specific instructions for the following:

• Installing the FlashBus Spectrim board
• Installing the FlashBus Spectrim software

Also in this chapter is a listing of system requirements for
running FlashBus Spectrim software.

2Installation
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Hardware Installation

To install FlashBus Spectrim, complete the following steps:

1. If necessary, set the jumper switches. (See Appendix A for more infor-
mation.)

2. Turn off your computer and disconnect all attached equipment and the
power cord. Remove the computer cover.

3. Firmly insert the FlashBus Spectrim board into an empty expansion slot
inside your computer. Screw its bracket to the inside of the back of the
computer.

4. Reassemble the computer. The connector should be accessible through
the back of the computer.

5. Turn on the computer and begin the software installation.
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Software Installation

The FlashBus Spectrim software has the following minimum system require-
ments:

• Intel Pentium or later computer
• 16 MB of RAM
• Microsoft Windows 95, 98, NT 4.0, 2000, XP, or ME operating

system

To install the software, complete the following steps:

1. Put the FlashBus Spectrim Setup disk in a CD-ROM drive and run
SETUP.EXE. You will be guided through the installation of all the soft-
ware components.

2. Select a 32K, 64K, or 16M color display mode when in onscreen cap-
ture to ensure color video input display. FBG can be used to verify your
board and software installation.

3. The TWAIN driver may need to be selected as the current TWAIN source
using the TWAIN applet in the Windows Control Panel.

4. Add the FlashBus Spectrim LIB and INCLUDE directories to your
compiler’s search paths before compiling the example code or your own
FlashBus Spectrim applications. Alternatively, copy the .LIB and .H files
to directories already in the search paths.
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Application

The FBG application controls all functions of FlashBus
Spectrim under Windows. FBG offers live video in a
resizable window and in a variety of video input types and
standards. FBG can also control flash video grabs, save
images to several file formats, and adjust a variety video
parameters.

The following information is included in this chapter:

• Configuring the video window
• Configuring video captures
• Adjusting video and image quality

The chapter is organized according to menu items avail-
able at the top of the FBG window.



10

File and Edit

The FBG file and edit menus contain standard Windows options. Following are
the notable options on the File menu (see Figure 1):

• Save Settings—saves the current FBG configuration for the next time
you open the application. To return FBG to default values, click Reset
on each appropriate panel (as described in the following sections) and
choose Save Settings again.

• Save Image...—saves an image in BMP, TGA, JPEG, or TIFF file for-
mat.

• Load Image...— retrieves saved images for viewing on the FBG win-
dow.

• Series File...—saves a series of images. First, enable a series capture (as
described in the next section). Then choose Series File..., type a filename,
and the series capture begins. Files are given the name you entered, ap-
pended with numbers that increase by one as the series progresses. See
the “Advanced Configuration” section of the next section for more about
file series.

Figure 1
The File menu
contains standard
Windows saving and
printing options.
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Tools

The Tools menu contains two important choices pertaining to the FBG video
window, remote video captures, image series captures, and more.

Configuration
Choosing Configuration... on the Tools menu opens the Configure panel (see
Figure 2), which contains the following options:

• Scale Video—resizes live video to fit within the FBG window. If you do
not select this, only a portion of the video appears in the window.

• Keep Aspect—maintains the video’s proportion even if the window is
resized. If you do not select this, the video is squeezed horizontally or
vertically to fit in the window.

• Field Rep—eliminates uneven flash illumination on images. Live video
consists of two rapidly alternating fields—one that displays video on
odd-numbered lines and one that displays video on even-numbered lines.
With a flash grab, one field is often illuminated more than the other.
When you select Field Rep, the even field is copied over the odd field to
even out the flash illumination.

• One Field—resizes video to less than or equal to 240 lines. This is small
enough that only one field is required.

• Offscreen— transfers video to the system memory first and then to the
VGA display memory.

• X Center—adjusts the horizontal position of the video in the view screen
to cover any black lines on the right or left sides.

• Y Center—adjusts the vertical position of the video in the view screen
to cover any black lines on the top or bottom.

• JPEG Q—changes the size of files that you save as JPEGs. Increasing
the value creates higher-quality JPEGs but requires greater storage space.

• Source—changes the camera displayed on the video screen. The cam-
era inputs are labeled 0–15, with 1 being the default.

Figure 2
The Configure panel
controls the size and
field aspects of the
FBG video screen.
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Advanced Configuration
Choosing Advanced Configuration... on the Tools menu opens another Configure
panel (see Figure 3), which contains the following options:

• Serial address—not used with FlashBus Spectrim.

• Remote Grab—allows you to use a remote trigger for a flash grab with
a compatible cable.

• Series Delay—sets the delay between each capture in a series. For ex-
ample, setting this to 10 causes FBG to capture every ten seconds. Un-
der the Series Delay setting are the following options:

• Series Off—disables the Series Delay (default).

• Timed Series—enables the Series Delay.

• Manual Series—allows you to capture an irregular frequency of
frames as part of a series.

• LTE Max Frames—captures the indicated number of frames in a single
long-term exposure. See the “Application Notes” chapter for more in-
formation about long-term exposure.

• SyncMode—required for certain LTE cameras (such as the Sony
DXC950 and 970).

• LTE Enable—enables the long-term exposure. You must change
the Camera Type before you click LTE Enable.

• LiveMode—not used with FlashBus Spectrim.

• Camera Type—change to 3 when using a long-term exposure camera.
You must select 3 before choosing LTE Enable (see the “Application
Notes” chapter for camera type information).

Figure 3
The advanced
Configure panel
controls series
captures and long-
term exposures.
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Setup

The Setup menu contains three choices for configuring video and image capture
adjustments.

Limit Window
Clicking on Limit Window limits the size of the video to a maximum of
640×480 in NTSC or 760×570 in PAL.

Video Setup
Clicking on Video... opens the Video Setup panel (see Figure 4), which contains
the following settings for live video in FBG:

• Brightness—changes the brightness of the live video.

• Contrast—changes the contrast of the live video.

• Saturation—changes the saturation of the live video. This is valid only
for composite and S-Video input.

• Hue—changes the hue of the live video. This is valid only for compos-
ite and S-Video input.

• Sharpness—changes the sharpness of the live video. This is valid only
for composite video input.

• Auto Iris—changes the iris voltage level (for auto-iris cameras only).
This can also be controlled on the Grab Setup panel.

• Standard—allows you to select either the NTSC (default) or PAL video
standard. NTSC is used in the Western Hemisphere, Japan, South Ko-
rea, The Philippines, and Taiwan. PAL is used almost everywhere else.

• Input Type—allows you to select the type of video input—RGB, com-
posite, S-Video, or YUV—depending on the type of camera (consult the
camera’s documentation).

Figure 4
The Video Setup
panel controls the
appearance of live
video and the video
input type and
standard.
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Effects
Clicking on Effects displays a menu that allows you to rotate the video image
clockwise (CW Rotation) or counterclockwise (CCW Rotation).

Grab Setup
Clicking on Grab... opens the Grab Setup panel (see Figure 5), which contains
the following settings for flash grabs and grabbed images:

• Brightness—changes the brightness of a captured frame.

• Contrast—changes the contrast of a captured frame.

• Field Delay—indicates the number of fields to wait between a flash and
a capture. This number is typically anywhere from 0 to 3.

• Line—indicates the number of lines to wait between a flash and a cap-
ture. This rarely needs to be changed from the default of 0.

• Auto Iris—changes the iris voltage level (for auto-iris cameras only).
This can also be controlled on the Video Setup panel.

• Align—indicates which field should be grabbed first. Any (default) is
usually sufficient, although Even or Odd is better when using a flash
grab (try both Even and Odd to determine which one is correct for the
situation).

• Type—indicates the type of camera and flash unit used (consult the
camera’s documentation).

Figure 5

The Grab Setup
panel controls the
appearance of
captured images and
flash parameters.
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FlashBus Spectrim Technical Specifications

Video Inputs
4 RGB or YCrCb component inputs
8 S-Video color inputs
16 composite or monochrome inputs
25-pin input connector
Video expansion header

Video Digitization
NTSC M, NTSC N, NTSC 4.43, NTSC-Japan, SECAM, PAL BGDHI, PAL N, and PAL M format support
ITU-601 digitization
Software programmable control of offset, gain, hue, and saturation
EEPROM for storing configuration and calibration settings

Video Acquisition
Philips TriMedia video processor
Smooth interpolated scaling to randomly sized windows
Bus-mastering video transfers to system or display memory
Hardware overlay of graphics over video
RGB 32/24/16/15/8 and YUV 4:2:2 pixel formats
Area of interest transfers to and from on-board and system memory
16 MB SDRAM frame buffer
Fast image switching of camera inputs up to 20 images/sec
Real-time image flip, mirror, or rotate

Video Output
Composite, S-Video, and component video output
Output video can be from video input with overlay, region of interest, or system memory

I/O Control
Optically isolated output trigger for flash interface
1 general purpose input trigger
2 general purpose output triggers
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External Control
On-board microcontroller
RS-232 control
Camera exposure control
Programmable DAC output (0V-10V)
12-volt DC output for camera power supply (fused at 1 amp)

Software Developers Kit
Windows 98, ME, NT 4.0, 2000, and XP DLLs
Video for Windows drivers
DirectDraw support
DirectShow support
Visual Basic support
TWAIN support
Sample applications with source code
Windows-based FBG capture application

Video Cables
Composite, S-Video, and component input and output cables available
Custom cables and connector

Physical and Environmental
Board Size: 4.2" × 5.375"
Power Consumption: 8.2 W
FCC and CE approved
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FlashBus Spectrim Jumper Settings

FlashBus Spectrim contains jumpers as indicated in the following diagram. The
functions of the jumper settings are described in the table.

Purpose JP1 JP2 JP3
Contact Closure Open Closed Open

Primary TTL Out Closed Open Open
Secondary TTL Out Open Open Closed

Primary and secondary TTL Out Closed Open Closed

JB
1

21 3
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FlashBus Spectrim DB-25 I/O Connector Pinout

The FlashBus Spectrim board contains a DB-25 I/O connector on its bracket. The
following diagram shows the pinout of the connector.

1

2
14

15

13

12
25

11
24

10
23

9
22

8
21

7
20

6
19

5
18

4
17

3
16

CV1/c3/R1/Cr 1 In

TTL Out 2/Flash Interface-
TTL Out 1/Flash Interface+
GND
TD (RS232/TTL LEVEL)
CS Out
RD (RS232/TTL LEVEL)
GND
+12V POW ER
Trigger (Switch) Input
DAC0 OUT (IRIS CONTROL)
GND
y/R/Cr Out
GND

 CV/G/Y Out
GND
c/B/Cb Out
CV4/c2/G2/Y2 In
CV3/y2/CS2 In
CV2/c4/R2/Cr2 In
GND
GND

CV7/y3/B1/Cb1 In
CV6/c1/G1/Y1 In

CV5/y1/CS1 In

Note
y and c are for S-Video

Y is for YUV



20

FlashBus Spectrim Video Expansion Connector

The FlashBus Spectrim video expansion connector allows you to expand to 4
RGB, 8 S-Video, or 16 composite video inputs when used with the DB-25 con-
nector. The following diagram shows the pinout of the connector.

1

3

2

4

25

23 24

21 22

19 20

17 18

15 16

13 14

11 12

9 10

7 8

5 6

CV12/c6/R3/Cr3

CV8/y4/B2/Cb2

CV15/y8/B4/Cb4

GND

GND

GND

GND

CV14/c7/G4/Y4

GND

CV11/y6/B3/Cb3

CV10/c5/G3/Y3

CV16/c8/R4/Cr4

GND

CV9/y5/CS3

26

CV13/y7/CS4

Note
y and c are for S-Video

Y is for YUV

NC

NC

NC

NC

NC

NC

NC

NCNC

NC

NC
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FlashBus Spectrim Lite Technical Specifications

Bus Format
PCI 2.2 Compliant
Universal slot

Video Inputs
3 Composite inputs
1 S-Video input
BNC or S-Video connector

Video Digitization
NTSC M, NTSC N, NTSC 4.43, NTSC-Japan, SECAM, PAL BGDHI, PAL N, and PAL M format support
ITU-601 digitization
Software programmable control of offset, gain, hue, and saturation
EEPROM for storing configuration and calibration settings

Video Acquisition
Philips TriMedia video processor
Smooth interpolated scaling to randomly sized windows
Bus-mastering video transfers to system or display memory
Hardware overlay of graphics over video
RGB 32/24/16/15/8 and YUV 4:2:2 pixel formats
Area of interest transfers to and from on-board and system memory
16 MB SDRAM frame buffer
Fast image switching of camera inputs up to 20 images/sec
Real-time image flip, mirror, or rotate

I/O Control
Optically isolated output trigger for flash interface
1 general purpose input trigger
1 general purpose output trigger

Software Developers Kit
Windows 98, ME, NT 4.0, 2000, and XP DLLs
Video for Windows drivers
DirectX support
Visual Basic support
TWAIN support
Sample applications with source code
Windows-based FBG capture application

(continued)
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Video Cables
Composite, S-Video, and component input and output cables available
Custom cables and connector pinouts available upon request

Physical and Environmental
Small form factor—2.5” × 4.721”
Low power consumption: 4W
FCC and CE approved
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FlashBus Spectrim Lite Jumper Settings

FlashBus Spectrim Lite contains jumpers as indicated in the following diagram.
The functions of the jumper settings are described in the table.

B1 B49 B52 B62

JB1

JB2

JB1

JB2

Switch JB1-1 JB1-2 JB1-3 JB1-4
Switch Closure Open Closed Closed Open

TTL I/O Closed Open Open Closed

PCI Signaling Level* JB2-1 JB2-2
3.3V Closed Open

5.0V Open Closed
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FlashBus Spectrim Lite Connector

The FlashBus Spectrim Lite PC bracket is equipped with three standard connec-
tors. The composite video input consists of a BNC female, and the S-Video input
is a four-pin female mini DIN. The following diagram shows the connectors on
the bracket.

S-Video Connector
4-pin mini DIN

Composite Video Connector
BNC Female
I/O Trigger Connector
Phono Female
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Expanded Cable with Video Output and Compos-
ite Sync—#3613

4-pin
Mini-DIN Male

S-Video

3
4
5
7

1,2,8,9

C
S

2
3

1,4

1
14
2
15
3,16

4
7

17
5
8

Red
Green
Blue
C Sync
GND

CV
GND

Y
C
GND

75 Ohm Coax

75 Ohm Quad Coax

C
S

C
S

C
S

6
18
7
19
8
20

GND
C/B/Uout
GND
CV/G/Yout
GND
Y/R/Vout

75 Ohm Coax

75 Ohm Coax

75 Ohm Coax

Photocoupler
Female
Flash

13
25

ACQ-IN
ACQ-OUT

1
2

BNC Male
Composite Video

D
B

-9
 M

al
e

R
G

B
 V

id
eo

D
B-

25
 M

al
e

75 Ohm Dual Coax

BNC Male
C/Blue/Uout

BNC Male
CV/Green/Yout

BNC Male
Y/Red/Vout

75 Ohm Coax

16
11

BNC Male
CS out

CS Out
GND

C
S
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Expanded Cable—#3610

D
B-

25
 M

al
e

DB-9 Male
RGB Video

4-pin
Mini-DIN Male

S-Video

Photocoupler
Female
Flash

BNC Male
Composite Video

3
4
5
7

1,2,8,9

C
S

2
3

1,4

1
2

1
14
2
15
3,16

4
7

17
5
8

13
25

Red
Green
Blue
C Sync
GND

CV
GND

Y
C
GND

ACQ-IN
ACQ-OUT

75 Ohm Coax

75 Ohm Dual Coax

75 Ohm Quad Coax
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Basic Cable—#3620

D
B-

25
 M

al
e BNC Male

Composite Video

C
S

4
7

CV
GND

75 Ohm Coax

4-pin
Mini-DIN Male

S-Video

2
3

1,4

17
5
8

Y
C
GND

75 Ohm Dual Coax
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Composite Video Cable—#3651 and #3654
This cable is sold in lengths of 6 feet (#3651) and 12 feet (#3654).

C
S

Photocoupler
Female
Flash

1/8" Male

BNC Male
Y

C
S

2
1,4

Y
GND

75 Ohm Coax

BNC Male
C

C
S

3
1,4

C
GND

75 Ohm Coax

4-pin
Mini-DIN Male

S-Video

BNC Male
Composite Video

C
S

75 Ohm Coax
BNC Male

Composite Video

C
S

4-pin
Mini-DIN Male

S-Video

4-pin
Mini-DIN Male

S-Video

2
3

1,4

2
3
1,4

Y
C
GND

75 Ohm Dual Coax

S-Video Cable—#3652

Flash Sync Cable—#3653

S-Video to Dual BNC Adapter Cable—#3655
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Technical Support

Integral Technologies is committed to providing you with superior technical and
engineering support. When you need help with your FlashBus Spectrim hard-
ware, please have the following information available:

• A complete description of the problem, including error messages and
instructions for re-creating the error.

• Your computer configuration, including brand, processor, speed, and
memory.

• Peripheral equipment you use with FlashBus Spectrim, including cam-
eras, cables, and so on.

• Environment (Windows 95/98/ME/NT/2000/XP).

• Compiler brand and version.

• Sample code whenever possible and applicable.

Send the report to:

Integral Technologies
9855 Crosspoint Blvd., Suite 126
Indianapolis, IN  46256-3336

Phone: (317) 845-9242
Fax: (317) 845-9275
Internet: support@integraltech.com
World Wide Web : http://www.integraltech.com

Technical Support Center Hours
Monday–Friday: 9:00 a.m.–5:00 p.m.*
Saturday–Sunday: Closed
Holidays: Closed
*Eastern Standard Time (GMT –05:00) all year
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Federal Communications Commission (FCC)
Radio Frequency Interference Statement

The FlashBus Spectrim video board contains incidental radio frequency-generat-
ing circuitry and, if not installed and used properly, may cause interference to
radio and television reception. This equipment has been tested and found to com-
ply with the limits for a Class A computing device pursuant to Subpart J of Part
15 of the Federal Communications Commission (FCC) Rules. These limits are
designed to provide reasonable protection against such interference when oper-
ated in a commercial environment. Operation of this equipment in a residential
area may cause interference to radio and television reception, in which case users
will be required to correct the interference at their own expense. If this equipment
does cause interference to radio or television reception, which can be determined
by turning the equipment off and on, users are encouraged to try to correct the
interference by one or more of the following measures: Re-orient the television
or radio receiving antenna, and/or relocate the FlashPoint board and the radio or
TV with respect to each other. If necessary, users should consult the manufac-
turer or an experienced radio/television technician for additional suggestions.
Users may find helpful the following booklet prepared by the Federal Communi-
cations Commission: “How to Identify and Resolve Radio-TV Interference Prob-
lems,” which is available from the Government Printing Office, Washington DC,
20402 (stock # 004-000-00345-4).

CE Notice

Marking by the symbol indicates compliance of this device to the EMC di-
rective of the European Community. Such marking is indicative that this device
meets or exceeds the following technical standards:

• EN55022:  Conducted Emissions, Class B
• EN55022:  Radiated Emissions, Class B
• IEC801-2:  Electrostatic Discharge (ESD) 8kV Air, 4kV Contact
• IEC801-3:  Radiated Immunity @3V/m, 27-1000MHZ, 80% modulated
• IEC801-4:  Electrical Fast Transients (EFT) 1kV supply
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Integral Technologies 1-Year Limited Warranty

What Does This Warranty Cover?
Integral Technologies (the “Company”) warrants to the Original Purchaser that
the Company’s hardware is free from defects in workmanship or material under
normal use and service. This warranty commences on the date of delivery of the
hardware to the Original Purchaser.

What are the Company’s Obligations Under This Warranty?
During the warranty period, the Company agrees to repair or replace, at its sole
option, without charge to Original Purchaser, any defective component part of
the hardware. To obtain service, Original Purchaser must return the hardware to
the Company in an adequate container for shipping. All defective products must
be returned to the Company within thirty (30) days of failure. Products must be
returned with a description of the failure and Return Merchandise Authorization
(RMA) number supplied by the Company. To receive a RMA number and obtain
assistance on where to deliver the hardware, call (317) 845-9242. The postage,
shipping, and insurance charges incurred in shipping to the Company will be
paid by Original Purchaser, and all risk for the hardware shall remain with the
Original Purchaser until such time as Company takes receipt of the hardware.
Upon receipt, the Company will promptly repair or replace the defective unit,
and then return said unit to Original Purchaser, postage and shipping prepaid.
The Company may use reconditioned or like-new parts or units, at its sole option,
when repairing any hardware. Repaired products shall carry the same amount of
outstanding warranty as from original purchase, or ninety (90) days, whichever is
greater. Any claim under the warranty must include dated proof of purchase or
invoice. In any event, the Company’s liability for defective hardware is limited to
repairing or replacing the hardware.

What Does This Warranty Not Cover?
This warranty is contingent upon proper use of the hardware by Original Pur-
chaser and does not cover: if damage is due to accident; unusual physical, electri-
cal, or electromechanical stress; modification; neglect; misuse; failure of electric
power, air conditioning, or humidity control; transportation; operation with me-
dia not approved by the Company; or tampering with or altering of the hardware.

What is the Length of the Warranty?
The warranties given herein, together with any implied warranties covering the
hardware, including any warranties of merchantability or fitness for a particular
purpose, are limited in duration to one year from the date of delivery to Original
Purchaser. Jurisdictions vary with regard to the enforceability of warranty limita-
tions, and you should check the provisions of your local jurisdiction to find out
whether the above limitation applies to you.
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What are the Limits on the Company’s Liability?
The Company shall not be liable to you for loss of data, loss of profits, lost savings, special, inciden-
tal, consequential, indirect, or other similar damages arising from breach of warranty, breach of con-
tract, negligence, or other legal action even if the Company or its agent has been advised of the
possibility of such damages, or for any claim brought against you by another party. Jurisdictions vary
with regard to the enforceability of provisions excluding or limiting liability for incidental or conse-
quential damages. You should check the provisions of your local jurisdiction to find out whether the
above exclusion applies to you.

This warranty allocates risks of product failure between Original Purchaser and the Company. The
Company’s hardware pricing reflects this allocation of risk and the limitations of liability contained
in this warranty. The warranty set forth above is in lieu of all other express warranties, whether oral or
written. The agents, employees, distributors, and dealers of the Company are not authorized to make
modifications to this warranty, or additional warranties binding on the Company. Accordingly, addi-
tional statements such as dealer advertising or presentations, whether oral or written, do not constitute
warranties by the Company and should not be relied upon.

This warranty gives you specific legal rights. You may also have other rights which vary from one
jurisdiction to another.

Integral Technologies
9855 Crosspoint Blvd., Suite 126
Indianapolis, Indiana  46256   U.S.A.


